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Safety

Safety notices
Safety notices may be printed throughout this guide. DANGER notices warn you of conditions or
procedures that can result in death or severe personal injury. CAUTION notices warn you of conditions or
procedures that can cause personal injury that is neither lethal nor extremely hazardous. Attention
notices warn you of conditions or procedures that can cause damage to machines, equipment, or
programs.

World trade safety information
Several countries require the safety information contained in product publications to be presented in their
translation. If this requirement applies to your country, a safety information booklet is included in the
publications package shipped with the product. The booklet contains the translated safety information
with references to the US English source. Before using a US English publication to install, operate, or
service this product, you must first become familiar with the related safety information in the Systems
Safety Notices, G229-9054. You should also refer to the booklet any time you do not clearly understand
any safety information in the US English publications.

Laser safety information
All IBM Z® (Z) and IBM LinuxONE™ (LinuxONE) models can use I/O cards such as FICON®, Open Systems
Adapter (OSA), InterSystem Channel-3 (ISC-3), RoCE Express, Integrated Coupling Adapter (ICA SR),
zHyperLink Express, or other I/O features which are fiber optic based and utilize lasers (short wavelength
or long wavelength lasers).

Laser compliance
All lasers are certified in the US to conform to the requirements of DHHS 21 CFR Subchapter J for Class 1
or Class 1M laser products. Outside the US, they are certified to be in compliance with IEC 60825 as a
Class 1 or Class 1M laser product. Consult the label on each part for laser certification numbers and
approval information.

Laser Notice: U.S. FDA CDRH NOTICE if low power lasers are utilized, integrated, or offered with end
product systems as applicable. Complies with 21 CFR 1040.10 and 1040.11 except for conformance with
IEC 60825-1 Ed. 3., as described in Laser Notice No. 56, dated May 8, 2019.

CAUTION: Data processing environments can contain equipment transmitting on system links with
laser modules that operate at greater than Class 1 power levels. For this reason, never look into the
end of an optical fiber cable or open receptacle. (C027)

CAUTION: This product contains a Class 1M laser. Do not view directly with optical instruments.
(C028)
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About this publication

This document is intended to help anyone who uses the stand-alone Input/Output Configuration Program
(IOCP).

• IBM z15™ (z15) / IBM LinuxONE III (LinuxONE III)
• IBM z14® (z14) / IBM LinuxONE Rockhopper II (Rockhopper II)
• IBM z14 (z14) / IBM LinuxONE Emperor II (Emperor II)
• IBM z13s® (z13s) / IBM LinuxONE Rockhopper (Rockhopper)
• IBM z13® (z13®) / IBM LinuxONE Emperor (Emperor)
• IBM zEnterprise® BC12 (zBC12)
• IBM zEnterprise EC12 (zEC12)
• IBM zEnterprise 114 (z114)
• IBM zEnterprise 196 (z196)
• System z10® Enterprise Class (z10 EC)
• IBM System z10 Business Class (z10 BC)
• System z9® Business Class (z9® BC)
• IBM System z9 Enterprise Class (z9 EC)

Intended audience
This users guide is intended for anyone using stand-alone IOCP to create input/output configuration data
set (IOCDS) files. You can use the information in this document to create an initial I/O configuration
source file (card-image statements) or to update existing files. It is written for both first-time data
processing users and experienced users, including system planners and administrators.

Read the manual in its order of presentation. Then follow the procedures in Chapter 2,
“Understanding the stand-alone version of IOCP,” on page 15 sequentially, to minimize the possibility
of error when creating your I/O configuration data set.

How this guide is organized
Chapter 1, “Introducing input/output configuration,” on page 1:

• Gives an overview of the I/O configuration program (IOCP)
• Lists the type of IOCP procedures
• Explains how an I/O configuration data set (IOCDS) is built

Chapter 2, “Understanding the stand-alone version of IOCP,” on page 15, is a step-by-step procedure
for creating an initial IOCDS for new system installations. It:

• Describes the IOCP Options (File actions) and View actions in detail
• Provides information about wait states

Chapter 3, “Running the stand-alone version of IOCP,” on page 47, provides examples of various
configurations.

Appendixes include:

• Appendix A, “Configuration examples,” on page 55. This appendix references the Input/Output
Configuration Program User's Guide, SB10-7172, for configuration examples.
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• Appendix B, “Resolving IOCP errors,” on page 57. This appendix provides instructions for resolving
errors.

• Appendix C, “Stand-Alone IOCP Support Element messages,” on page 59. This appendix contains an
error example and explanations of messages.

Prerequisite and related information
You must have a basic knowledge of IOCP tasks to use this manual effectively.

Important

For IOCP statement syntax, detailed error message descriptions, I/O device and control unit parameters,
ESCON channel examples, and IOCP instructions for specific operating systems (z/OS®, z/OS.e, z/VM®,
VSE/ESA, and z/VSE®), see Input/Output Configuration Program User's Guide, SB10-7172.

Figures in this guide
There are representations of the Hardware Management Console and Support Element windows
throughout this manual. These windows might or might not represent in appearance what is displayed on
your console. These figures are to help you recognize the information that you see while performing the
procedures in this guide. The information might not match what is displayed on your system. Always use
the instructions and data displayed on your system.

Terms used in this guide
The following terms are used when configuring the channels.

I/O devices
The I/O devices are the input/output controllers and devices that attach to a standard channel for a IBM
Z®, System z10, or System z9.

I/O configuration data set (IOCDS)
The IOCDS defines the configuration of I/O devices on the system to the Licensed Machine Code (LMC)
used by the channels. The IOCDS is stored on the Support Element. Only one IOCDS can be used during
system activation, but up to four IOCDSs can be defined.

I/O configuration program (IOCP)
The IOCP is a stand-alone utility on the Support Element that creates the IOCDS for the Z, System z10, or
System z9 server. The input to the IOCP is the I/O configuration source file.

I/O configuration source (IOCS)
The I/O configuration source file is input to the IOCP when an IOCDS is created. The I/O configuration
source is an 80-column card-image, and is initially provided in ASCII format. The file is then imported to
the hard disk of the Support Element. It is the responsibility of the customer to create the I/O
configuration source; however, the service representative can edit the file to correct errors.

Revisions
Within each topic, a technical change from the previous edition of the information is indicated by double
angle brackets () surrounding the text or illustration.
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Accessibility
Accessible publications for this product are offered in EPUB format and can be downloaded from
Resource Link® at http://www.ibm.com/servers/resourcelink.

If you experience any difficulty with the accessibility of any IBM Z® and IBM LinuxONE information, go to
Resource Link at http://www.ibm.com/servers/resourcelink and click Feedback from the navigation bar
on the left. In the Comments input area, state your question or comment, the publication title and
number, choose General comment as the category and click Submit. You can also send an email to
reslink@us.ibm.com providing the same information.

When you send information to IBM®, you grant IBM a nonexclusive right to use or distribute the
information in any way it believes appropriate without incurring any obligation to you.

Accessibility features
The following list includes the major accessibility features in IBM Z and IBM LinuxONE documentation,
and on the Hardware Management Console and Support Element console:

• Keyboard-only operation
• Interfaces that are commonly used by screen readers
• Customizable display attributes such as color, contrast, and font size
• Communication of information independent of color
• Interfaces commonly used by screen magnifiers
• Interfaces that are free of flashing lights that could induce seizures due to photo-sensitivity.

Keyboard navigation
This product uses standard Microsoft Windows navigation keys.

Consult assistive technologies
Assistive technology products such as screen readers function with our publications, the Hardware
Management Console, and the Support Element console. Consult the product information for the specific
assistive technology product that is used to access the EPUB format publication or console.

IBM and accessibility
See http://www.ibm.com/able for more information about the commitment that IBM has to accessibility.

How to send your comments
Your feedback is important in helping to provide the most accurate and high-quality information. Send
your comments by using Resource Link at http://www.ibm.com/servers/resourcelink. Click Feedback on
the navigation bar on the left. You can also send an email to reslink@us.ibm.com. Be sure to include the
name of the book, the form number of the book, the version of the book, if applicable, and the specific
location of the text you are commenting on (for example, a page number, table number, or a heading).

About this publication  xvii
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Chapter 1. Introducing input/output configuration

What is the I/O configuration process
All CPCs require input describing how their I/O channels and devices are configured. You must supply this
information in a source file known as the input/output configuration source (IOCS). The IOCS contains
detailed information for each channel path assignment, each control unit, and each device. For
information about the source file statement syntax and content, see the Input/Output Configuration
Program User's Guide, SB10-7172.

The system programmer can create the IOCS in advance and save it on a diskette (for System z10 or
System z9), hard disk drive, or USB flash drive in a PC file (in ACSII format). The IOCS can also be created
or altered using the editor that the stand-alone Input/Output Configuration Program (IOCP) provides on
the Support Element.

IOCP uses the IOCS to create an input/output configuration data set (IOCDS). The CPC uses the IOCDS
during power-on reset to tell the I/O subsystem how the I/O is configured. Four possible I/O
configurations (four IOCSs and four corresponding IOCDSs) are available for a normal power-on reset; a
fifth data set D0 is for diagnostic procedures.

When is the stand-alone version of IOCP needed?
The stand-alone version of IOCP is needed only:

• When you generate (Build) an I/O configuration data set during initial installation
• If your operating system does not have a batch version of IOCP
• If you want to change the I/O configuration and do not have one of the following operating systems

operational:

– VSE/ESA
– z/OS
– z/OS.e
– z/VM
– z/VSE

Notes:

1. If, after system installation and activation, you are operating with either the z/OS, z/OS.e, z/VM, z/VSE,
or VSE/ESA system control program, you can use the batch version of IOCP to make IOCDS changes.
The advantage of the batch version of IOCP is that it does not disrupt system processing as does the
stand-alone version of IOCP.

2. The Hardware Configuration Definition (HCD) is an z/OS, z/OS.e, and z/VM application that aids in the
definition of the I/O configuration and in the distribution of the appropriate I/O definition to the
appropriate CPCs. The Hardware Management Console, configured as a change management focal
point with Licensed Machine Code changes enabled, assists the HCD in finding the names of all
defined CPCs. A single HCD then distributes the appropriate IOCDS to the various CPCs.

What can the stand-alone version of IOCP do?
Using the stand-alone version of IOCP, you can:

© Copyright IBM Corp. 2017, 2019 1



• Create a new IOCDS during the installation of a new CPC, if an I/O configuration source file (card-image
input statements) is not available.

• Update an IOCDS on an existing CPC. In some cases where the source file was not saved or if you are
unsure of the source, you can use the Disassemble Data Set action.

• Disassemble Data Set gets an equivalent source deck from an existing IOCDS.
• Replace an IOCDS in a CPC if card-image input is available from one of the supported import devices.

How to start the I/O configuration process
The stand-alone version of IOCP is shipped with the CPC as part of the Licensed Machine Code (LMC). You
can use the stand-alone program to define the I/O configuration to the system before a control program is
installed.

To start the I/O configuration process you must perform the following tasks:

1. Log on the Support Element in the System Programmer or Service Representative user role. (You can
log on directly or through the Single Object Operations task; see “Logging on the Support Element” on
page 2.)

2. For an IOCP task on a partition (see Note), perform a power-on reset of the server. (See “Performing a
power-on reset” on page 5.)

3. For an IOCP task on a partition, activate a partition. (See “Activating a partition” on page 8.)
4. Start the IOCP program. (See “Starting the IOCP program” on page 9.)

Note: Many IOCP actions are run on the Support Element. However, certain actions (Print Data Set
Report, Build Data Set, and Disassemble Data Set) are run on an activated partition. These actions
require performing a power-on reset of the server and activating the target partition with partition I/O
Configuration Control Authority enabled through its activation profile. Other IOCP actions do not require
these steps.

The following sections provide the steps for performing these four tasks.

Logging on the Support Element
You can log on the Support Element directly or use the Single Object Operations task on the Hardware
Management Console to operate the Support Element. The following steps describe how to log on using
Single Object Operations.

1. Log on the Hardware Management Console in the System Programmer or Service Representative user
role. The Hardware Management Console workspace Welcome window is displayed.

Note: The tree style user interface is the interface for both the Hardware Management Console and
the Support Element.

2. From the Hardware Management Console workspace window, in the navigation pane in the left portion
of the window, expand Systems Management if it is not already expanded. This action displays the
systems under Systems Management. Figure 1 on page 3 shows this expansion. 
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Figure 1. Systems Management expanded
3. Click Systems Management to expand it. This action displays a list of systems.
4. Click the target system to select it. The tasks pad at the bottom of the work pane in the right portion of

the window displays types of tasks that are available. Figure 2 on page 3 shows these types of
tasks. 

Figure 2. System selected and task categories displayed
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5. In the tasks pad, expand Recovery. The Single Object Operations task is displayed. Figure 3 on page
4 shows this result. 

Figure 3. Recovery expanded
6. Click Single Object Operations. The Single Object Operations Task Confirmation window is displayed.

Figure 4 on page 4 shows this window. 

Figure 4. Single Object Operations Task Confirmation window

Click Yes. You might receive a message asking you to wait. The Support Element workspace window is
displayed. Figure 5 on page 5 shows this window (with the tree style user interface). 
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Figure 5. Support Element workspace window

Performing a power-on reset
Note: You need not perform a power-on reset unless you are performing IOCP tasks requiring a partition.
See the note under “How to start the I/O configuration process” on page 2 for details.

Log on the Support Element in either the System Programmer or Service Representative user role.
Perform the following steps for a power-on reset on the server.

Note: The Power-On Reset task is prevented from running if the Support Element has locked out
disruptive tasks.

1. In the Support Element workspace, in the navigation pane on the left, expand System Management if
it is not already expanded. This action displays the system. Click the server to select it. This action
displays tasks categories, such as Recovery, in the tasks pad at the bottom of the work pane. Figure 6
on page 6 shows these categories. 
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Figure 6. System selected and task categories displayed

Expand Recovery. This action the Power-on Reset task. Figure 7 on page 6 shows this task in the
list. 

Figure 7. Power-On Reset task displayed
2. Click Power-on Reset to start the task. This action opens the Power-on Reset window. Figure 8 on

page 7 shows this window.
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Note: Before this window is displayed, you might get a message stating: Power-on Reset Busy:
Retrieving power-on reset data. This message closes automatically when the Power-on Reset
window opens.

Figure 8. Power-on Reset window
3. Make sure that the appropriate input/output configuration data set is selected, and click Perform

Power-on Reset. A Power-on Reset confirmation window is displayed. Figure 9 on page 7 shows
this window. 

Figure 9. Power-on Reset confirmation window

Click Yes. A Power-on Reset Progress window is displayed. 

Figure 10. Power-on Reset Progress window

When the Power-on Reset task is completed, click OK.
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Activating a partition
Note: You need not activate a partition unless you are performing IOCP tasks requiring it. See the note
under “How to start the I/O configuration process” on page 2 for details.

z13 systems, and prior systems 128 MB of storage (MB equals 1 048 576 bytes). Also, the logical
partition must be activated with I/O Configuration Control Authority enabled through its activation profile.
Perform the following steps to activate a partition.

1. Expand Partitions if this item is not already expanded, and click a partition. This action displays
categories of tasks in the tasks pad. Figure 11 on page 8 shows these categories. 

Figure 11. Partition selected and its task categories displayed
2. Expand Daily, and click the Activate task under it. This action displays the Activate Task Confirmation

window. Figure 12 on page 8 shows this window. 

Figure 12. Activate Task Confirmation window

Note: To use the stand-alone IOCP on a coupling facility, perform a power-on reset with the Diagnostic
IOCDS (D0) and activate a logical partition. IOCP can run only in a logical partition activated for
ESA/390 mode for a z13 and prior CPCs or General mode for a z14 or later.

3. In the Activate Task Confirmation window, click Yes. This action displays the Activate Progress
window. Figure 13 on page 9 shows this window. 
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Figure 13. Activate Progress window
4. When the activation is done, click OK.

Starting the IOCP program
Perform the following steps to use the Input/Output (I/O) Configuration task:

1. In the Support Element workplace window, in the navigation pane in the left portion of the window,
ensure System Management and the system are expanded. You can use the Input/Output (I/O)
Configuration task on a server or a partition. If the task target is a partition, ensure Partitions is
expanded. Figure 14 on page 9 shows these expansions in the navigation pane on the left.

Note: The following IOCP tasks require selecting a partition:

• Print Data Set Report
• Build Data Set
• Disassemble Data Set

See Note “1” on page 17 for complete details.
2. In the tasks pad, expand Configuration. Figure 14 on page 9 shows this window. 

Figure 14. Navigation expanded on left and task category expanded on right
3. Click Input/Output (I/O) Configuration. This action displays the Input/Output Configuration

window. Figure 15 on page 10 shows this window. You can perform any of the functions available on
the Input/Output Configuration window. 
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Figure 15. Input/Output Configuration window

How to use the interface
The stand-alone program uses the object-action user interface and is designed for use with a keyboard or
a mouse. If you are not familiar with using menu bars, a mouse, or the Support Element interface, see:

• Hardware Management Console (HMC) and Support Element (SE) information can be found on the
console help system.

Clicking a menu item in the Input/Output Configuration window displays the actions under it. For
example, Figure 16 on page 10 shows the actions under View in the Input/Output Configuration
window.

Figure 16. Input/Output Configuration window - View actions

In IOCP, you can select an action from a menu by clicking it or by pointing the cursor at it and click Enter.
For simplicity, this guide uses the term click.

Note:

1. You might need to use other documents to create the I/O configuration source (IOCS) before using
this guide.

2. For IOCP statement syntax, detailed error message descriptions, and IOCP instructions for running the
batch IOCP with specific operating systems (for example, z/OS and VM), see Input/Output
Configuration Program User's Guide, SB10-7172.

3. The stand-alone version of IOCP does not have I/O recovery capability. I/O error conditions cause
IOCP to stop.
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How to determine the IOCP release level
To determine the IOCP release level installed on your Support Element, perform the following steps:

1. Perform the steps under “Starting the IOCP program” on page 9.
2. From the Input/Output Configuration window, click View.
3. Click Configuration Program Level.
4. Read the version/release/level of the IOCP Licensed Machine Code installed on this system.

I/O configuration source files
Stand-Alone IOCP removes any comment card that begins with *ICP or *IYP. Stand-Alone IOCP uses
*ICP comments for IOCP messages. Therefore, when Building an IOCDS, stand-alone IOCP removes
these IOCP messages so the resultant IOCS file contains only IOCP messages from the selected function.

IOCS files can contain a maximum number of 256,000 source card records. Twenty additional records are
reserved for IOCP messages.

If you Build an IOCDS and the resultant IOCS file is too large, IOCP removes IOCP messages from the
IOCS file to reduce its size until it is small enough to be written.

If an IOCP function fails due to space constraints or if IOCP messages were removed from the IOCS file,
you can reduce the size of the IOCS file you chose and then retry the IOCP function. To reduce the size of
an IOCS file, perform one or more of the following:

• Remove comment cards from an IOCS file.
• Consolidate IOCP statements that are continued across multiple cards onto a minimum number of

cards.
• Combine individual IODEVICE statements that attach to the same control units by using common UNIT

and MODEL keyword values. Do not combine IODEVICE statements if they have conflicting keyword
values.

Note: For small size and efficiency, the preceding can also be done for any IOCS file, not only for IOCS
files that are too large.

Starter I/O configuration data sets
The system can have four I/O configurations available to the user. There are four user I/O configuration
data sets (IOCDSs) shipped with the machine, called starter data sets, plus a diagnostic configuration data
set that service representatives use. The starter data sets are provided as examples only and are not
intended to match the actual I/O configuration the customer has.

The system must be power-on reset, and a logical partition must be activated before running the stand-
alone IOCP.

Figure 17 on page 12 shows the Input/Output Configuration window, listing the configuration data sets.
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Figure 17. Input/Output Configuration window

The IOCDSs shipped with the machine are:

• The A0, A1, A2, and A3 STARTER configuration data sets.
• The D0 DIAGNOSE configuration data set, which is used for diagnostic testing.

– D0 puts all channels in a simulation mode. No external I/O can be accessed when the system has
been power-on reset using this IOCDS.

– The stand-alone IOCP can be run after a power-on reset using D0.
– IPL cannot be performed for operating systems if D0 was used at power-on reset.

To view the contents of the starter data sets, on the menu bar of the Input/Output Configuration window,
click Options > Open Source File. Figure 18 on page 12 shows these choices.

Figure 18. Input/Output Configuration window - Options

Description of a stand-alone build of an IOCDS
IOCP performs the following steps when you specify that you want to generate or build an IOCDS using
the Build Data Set action.

1. The Support Element sets the targeted logical partition (System Reset Clear). The logical partition
must be activated with I/O Configuration Control Authority enabled through its activation profile.
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2. The Support Element loads the stand-alone IOCP into the storage of the targeted logical partition and
starts the program.

3. IOCP reads the entire source file from the Support Element.

Note: IOCP Steps “4” on page 13 through “5” on page 13 are repeated for each input statement.
4. IOCP checks the syntax of each statement for correct format. If a syntax error is found (such as a

missing parenthesis), IOCP inserts an error message in the card-image file following the statement
that contains the error. IOCP stops checking the syntax of a statement when it encounters the first
syntax error on that statement. Therefore, if there are two or more syntax errors on a single
statement, the second and following errors are found on subsequent runs of IOCP.

If IOCP finds an error in Step “4” on page 13, it performs Steps “4” on page 13 and “5” on page 13
for the remainder of the statements and then continues with Step “9” on page 13.

5. IOCP checks the validity of each statement. For example, IOCP checks that a CNTLUNIT statement
has specified a channel path that has been previously defined in a CHPID statement. If an error is
found, IOCP inserts an error message in the card-image file following the statement that contains the
error.

If IOCP finds an error in Step “5” on page 13, IOCP returns to Step “4” on page 13 and performs only
Steps “4” on page 13 and “5” on page 13 for the remainder of the statements and then continues
with Step “9” on page 13.

6. After all of the input statements have been processed, IOCP generates the IOCDS and makes
additional checks. For example, IOCP checks that the maximum number of control unit headers is not
exceeded. If IOCP finds an error, IOCP inserts an error message at the end of the card-image file and
continues with Step “9” on page 13.

7. IOCP produces IOCP configuration reports of the IOCDS generated.
8. IOCP writes the IOCDS file to the Support Element if no errors were found.
9. IOCP writes the source file to the Support Element. If errors were detected, error messages are

embedded in the source file. Even if the build was successful, warning messages might be embedded
in the source file. Review any warning messages before using the IOCDS.

10. The Support Element ends the IOCP program. (Starting the IOCP code after this point causes IOCP to
put the central processor (CP) in a B20 hard wait state.)
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Chapter 2. Understanding the stand-alone version of
IOCP

Controlling the program
The stand-alone version of IOCP is started and controlled from the Support Element. Log on the Support
Element in the System Programmer or Service Representative user role, and start the IOCP program. See
“Logging on the Support Element” on page 2 and “Starting the IOCP program” on page 9 for the steps to
perform these tasks.

After you start the IOCP program, the Input/Output Configuration window is displayed. Figure 19 on page
15 shows this window. 

Figure 19. Input/Output Configuration window

Navigating the I/O configuration windows
The Input/Output Configuration window is the starting point for all of the stand-alone IOCP functions.

There are four user I/O configuration data sets, identified as A0 through A3. These data sets have names
that you, as the system owner, supply. The fifth data set, D0, is a diagnostic data set. D0 cannot be
altered. It is intended for service personnel to use, with the following possible exception. If you are on a
coupling facility or cannot perform a power-on reset using any of the A0 through A3 data sets, you can
use D0 to perform the power-on reset. You cannot access I/O after a D0 power-on reset.

If a data set is displayed on the IOCDS matching hardware system area (HSA) line, that data set is a
dynamic-capable IOCDS, which is equivalent to the I/O configuration in the hardware system area (HSA).
A dynamic-capable IOCDS is one written using the HCD software tool on z/OS, z/OS.e, or VM or specifying
IOCP CMS utility option DYN for VM. If a data set is displayed on the Active input/output configuration
data set (IOCDS) line, that data set has a Data Set Status of Active.

The Input/Output Configuration window has an Options menu (see Figure 20 on page 17) that you can
use to change the status or the content of the selected I/O configuration. The Input/Output Configuration
window and the Options and View menus are all explained in greater detail on the following pages. The
important point here is that this window provides access to all of the information about the configuration
data sets currently available on the system, and the Options menu permits you to change that
information.
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Input/output configuration window

The Input/Output Configuration window (see Figure 19 on page 15) displays the following information:

Data Set
Is a 2-character identifier for the IOCDS. There are four IOCDSs (A0, A1, A2, and A3) that you can
alter. “Starter I/O configuration data sets” on page 11 describes them.

Name
Is an 8-character name that is the identification of the IOCDS. The name comes from the first 8
characters that you have entered in the MSG1= keyword value in the ID statement. The displayed
name is saved from the IOCDS when it is written to the Support Element.

Write Protected
N indicates that the IOCDS is not write-protected. Y indicates that the IOCDS is write-protected.
Write-protection prevents the IOCDS from being overwritten by batch IOCP or stand-alone IOCP and
from being overlaid by Copy Configuration. Write-protection also prevents the I/O configuration
source (IOCS) file from being:

• Overlaid by Disassemble Data Set, Build Data Set, or Import Source File from the Hardware
Management Console Diskette (for System z10 or System z9), Hardware Management Console
USB Flash Memory Drive, or FTP Location

• Edited by Open Source File
• Deleted by Delete Source File

Date
Month, day, and year when the IOCDS was built.

Time
Hour and minute when the IOCDS was built. (Displayed in 24-hour format.)

Data Set Status
Can be one of the following:

• Valid means the IOCDS is usable for power-on-reset (POR) purposes. Its content matches the
source file only if the source status is Verified or Warnings.

• Invalid means the IOCDS is not usable for power-on reset purposes and some IOCP actions. Either
IOCP is currently writing to the IOCDS or the IOCDS was written in preparation for a CPC upgrade
and is unusable until the CPC is upgraded to the type of CPC supported by the IOCDS.

• Active means this IOCDS was used during the most recent power-on reset or was selected by a
dynamic activation from the System Control Program (SCP). Only one IOCDS can be active at a given
time. The active IOCDS is made write-protected by the Support Element during POR with the IOCDS
or after a dynamic activation by the SCP. The write protection can be removed with the Disable
Write Protection action.

Source Status
Can be one of the following:

• Verified means the stand-alone IOCP Build was processed with this source and was successful with
no warnings or errors.

• Warnings mean the stand-alone IOCP Build was processed with this source and was successful with
one or more warnings or caution messages.

• Errors means the stand-alone IOCP Build was processed with this source and was not successful.
There was a terminal error.

Note: No IOCDS is written and the IOCDS remains as it was before the Build.
• Modified means that the source file has been changed by editing the file. This status also indicates

that the source might not match the current IOCDS.
• Imported means that the source file was overlaid by an import from the Hardware Management

Console Diskette (for System z10 or System z9), Hardware Management Console USB Flash
Memory Drive, or FTP Location.
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• Empty means that the source file has been deleted or was erased when a batch IOCP program wrote
the IOCDS.

• Unknown means that there is an error with the source file status.

Version
Identifies the version of IOCP that was used to create the IOCDS.

Using the I/O configuration program options
The Input/Output Configuration window provides access to all of the information about the configuration
data sets currently available on the system. Options (see Figure 20 on page 17) permit you to change
that information. The following sections explain the Options menu and several other menus in greater
detail.

Figure 20. Input/Output Configuration window - Options

Clicking Options displays a list of actions (shown in Figure 20 on page 17). The actions under Options
permit changing the status or the content of the selected I/O configuration. Choose the action to perform
by clicking it or by pointing the cursor at it and clicking Enter.

The actions under Options include:

• Enable Write Protection
• Disable Write Protection
• Copy Configuration
• Export Source File
• Import Source File
• Open Source File
• Delete Source File
• Print Data Set Report
• Build Data Set
• Disassemble Data Set
• Exit

Notes:

1. The Print Data Set Report, Build Data Set, and Disassemble Data Set actions require activating the
targeted logical partition with I/O Configuration Control Authority enabled through its activation
profile. All other actions are performed on the Support Element and do not require the stand-alone
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IOCP code to be loaded and run in a logical partition, and they do not require an activated partition and
power-on reset of the CPC.

2. Print Data Set Report, Build Data Set, and Disassemble Data Set load the stand-alone IOCP code
into a logical partition and run the code on a central processor. Selecting one of these actions displays
the Disruptive Task Confirmation window. 

3. Figure 21 on page 18 shows the Disruptive Task Confirmation window. This window warns that any
processor program or operating system in the targeted logical partition will be overlaid with the stand-
alone code to perform these functions. 

Figure 21. Disruptive Task Confirmation window

If you want to continue with the action you have chosen, you type the password for the specified user
role and click Yes. If you do not want to continue with the action, you click No. This window is
presented only the first time the IOCP stand-alone code is loaded into a logical partition.

The sections that follow provide a brief overview of each Options action. A reference at the end of each
overview indicates where to find detailed descriptions.

Enable Write Protection
This action protects the I/O configuration data set (IOCDS) and I/O configuration source (IOCS) files on
the hard disk from being overwritten. If a file is protected, a Y is displayed on the Input/Output
Configuration window under the Write Protected heading for the selected configuration. If you want to
replace an IOCDS or IOCS that is write-protected, you must first remove the write protection using the
Disable Write Protection action.

Disable Write Protection
This action resets the protected status of the I/O configuration data set (IOCDS) and the I/O configuration
source (IOCS) files on the hard disk. Files without write protection can be overwritten. Unprotected files
are displayed on the Input/Output Configuration window with an N under the Write Protected heading for
the selected configuration.
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Copy Configuration
This action copies the I/O configuration data from one IOCDS to another. You might do this action to
duplicate an existing I/O configuration so you can test some changes on the copy. Both the source and
IOCDS are copied.

When you choose the Copy Configuration action on the Input/Output Configuration window (see Figure
20 on page 17), the window shown in Figure 22 on page 19 is displayed:

Figure 22. Copy Configuration window

Use this window to duplicate I/O configurations (IOCDS file and source IOCP card-image file if it exists).

The source configuration is displayed (for example, A1) as is the target configurations to be overlaid (for
example, A0, A2, A3). If you have designated certain configurations as write-protected, they are not
displayed as copy targets. Also, the active configuration is displayed only if write protection has been
removed.

Export Source File
Export Source File transfers the card-image source file from the hard disk of the Support Element to the
Hardware Management Console, the Hardware Management Console USB Flash Memory Drive, or an FTP
location. Targets for the file are summarized in the following table:

Table 1. Summary of available targets for export

Source IBM Z
IBM zEnterprise
System System z10 System z9

A diskette in the
3.5-inch A-drive in
the Hardware
Management
Console

No No Yes Yes

A USB flash
memory drive in
the Hardware
Management
Console

Yes Yes Yes No

An FTP location Yes Yes Yes Yes

On the Input/Output Configuration window, under Options > Export Source File, additional choices can
include:

• Hardware Management Console Diskette (System z10 and System z9)
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• Hardware Management Console USB Flash Memory Drive (IBM Z, IBM zEnterprise System, and
System z10)

• FTP Location

A diskette drive is not available on the IBM Z and IBM zEnterprise System. The selection Hardware
Management Console USB Flash Memory Drive is for the IBM Z, IBM zEnterprise System and System
z10 only. Figure 23 on page 20, Figure 24 on page 20, and Figure 25 on page 21 show some
examples of the Input/Output Configuration window listing available choices for several systems.

Figure 23. Export Source File options -IBM zEnterprise System and later

Figure 24. Export Source File options - System z10
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Figure 25. Export Source File options - System z9

Click the target device to which to export the I/O configuration source (IOCS) file. The active selections for
exporting depend on whether you are operating from the Support Element or Hardware Management
Console and your system.

If you click Hardware Management Console Diskette (for System z10 or System z9), the Export to HMC
Diskette window is displayed (see Figure 26 on page 21).

Note: If the diskette has insufficient space to contain the IOCS file, the IOCS file is compressed using a
zip compatible program. If there is insufficient space for the compressed file, the export fails.

Figure 26. Export to HMC Diskette window (System z10 and System z9)

If you click Hardware Management Console USB Flash Memory Drive the Export to HMC USB Flash
Memory Drive window is displayed. (See Figure 27 on page 21.)

Figure 27. Export to HMC USB Flash Memory Drive window (IBM Z, IBM zEnterprise System, and System
z10)
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From either of these windows:

1. Type in the target file name.
2. Click OK.

If you click FTP location, the File Transfer Information window is displayed. (See Figure 28 on page 22.)

Figure 28. File Transfer Information window

From this window:

1. Specify the FTP host name address or destination.
2. Enter the user name for the target FTP destination.
3. Enter the password, if any, associated with the user name for the target FTP destination.
4. Optionally, select Use secure FTP to enable a secure FTP connection to your server.
5. Choose a secure network protocol for transferring files.

• FTP (File Transfer Protocol) - This is the default.
• FTPS (FTP Secure)

If you need to import an FTPS server certificate, use the Certificate Management task. From the
Advanced drop-down select Manage Trusted Signing Certificate. The Manage Trusted Signing
Certificate window is displayed. From the Export drop-down, select From Remote Server. The
Export Remote Certificate window is displayed. Provide the IP/Host address and port number, then
click OK to confirm. The Confirm Export window is displayed, then click Yes after you verified the
certificate information.

• SFTP (SSH File Transfer Protocol)

If you need to import SSH server keys, use the Manage SSH Keys task. Provide the SFTP server ID in
the Address input area, then click Add.
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6. Specify the FTP server directory where files are to be saved to or read from.
7. Click OK.

Import Source File
Import Source File transfers the card-image input to the hard disk of the Support Element from sources
as summarized in the following table:

Table 2. Summary of available targets for import

Source IBM Z
IBM zEnterprise
System System z10 System z9

A diskette in the
3.5-inch A-drive in
the Hardware
Management
Console

No No Yes Yes

A USB flash
memory drive in
the Hardware
Management
Console

Yes Yes Yes No

An FTP location Yes Yes Yes Yes

You can edit the source and use it to build an IOCDS.

The source file must contain text characters. If importing from diskette, it must either be in DOS file
format or have been compressed (for example, using a zip compatible program). If the file is compressed,
it must contain a single source file. The source file name must have a maximum of 8 characters, and the
file extension must have a maximum of 3 characters. If importing from USB flash memory drive, the
source file can be in VFAT or DOS file format or have been compressed.

On the Input/Output Configuration window, under Options > Import Source File, additional choices can
include:

• Hardware Management Console Diskette (System z10 and System z9)
• Hardware Management Console USB Flash Memory Drive (IBM Z, IBM zEnterprise System, and

System z10)
• FTP Location

A diskette drive is not available on the IBM Z and IBM zEnterprise System. The selection Hardware
Management Console USB Flash Memory Drive is for the IBM Z, IBM zEnterprise, and System z10 only.
Figure 29 on page 24, Figure 30 on page 24, and Figure 31 on page 24 show some examples of the
Input/Output Configuration window listing available choices for several systems.
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Figure 29. Import Source File options - IBM zEnterprise System and later

Figure 30. Import Source File options - System z10

Figure 31. Import Source File options - System z9

Click the source device from which to import the card-image statements (source) file. The active
selections for importing depend on whether you are operating from the Support Element or Hardware
Management Console and what system you are using.
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If you click Hardware Management Console Diskette (for System z10 or System z9), the Import from
HMC Diskette window is displayed. For more information, see Figure 32 on page 25.

Figure 32. Import from HMC Diskette window - System z10, System z9

If you click Hardware Management Console USB Flash Memory Drive (for IBM Z, IBM zEnterprise
System, and System z10), the Import from HMC USB Flash Memory Drive window is displayed. (See
Figure 33 on page 25.) 

Figure 33. Import from HMC USB Flash Memory Drive window - IBM Z, IBM zEnterprise System, System z10

From either window:

1. Select the Source file name.
2. Click OK.

If you click FTP Location, the File Transfer Information window is displayed. (See Figure 34 on page 26.)
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Figure 34. File Transfer Information window

From this window:

1. Specify the FTP host name address or destination.
2. Enter the user name for the target FTP destination.
3. Enter the password, if any, associated with the user name for the target FTP destination.
4. Optionally, select Use secure FTP to enable a secure FTP connection to your server.
5. Choose a secure network protocol for transferring files.

• FTP (File Transfer Protocol) - This is the default.
• FTPS (FTP Secure)

If you need to import an FTPS server certificate, use the Certificate Management task. From the
Advanced drop-down select Manage Trusted Signing Certificate. The Manage Trusted Signing
Certificate window is displayed. From the Import drop-down, select From Remote Server. The
Import Remote Certificate window is displayed. Provide the IP/Host address and port number, then
click OK to confirm. The Confirm Import window is displayed, then click Yes after you verified the
certificate information.

• SFTP (SSH File Transfer Protocol)

If you need to import SSH server keys, use the Manage SSH Keys task. Provide the SFTP server ID in
the Address input area, then click Add.

6. Specify the FTP server directory where files are to be saved to or read from.
7. Click OK.

Open Source File
The Open Source File action opens an editor where you can:
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• Change an existing I/O configuration source
• Create new card-image statements

Note: If you edit a dynamic I/O configuration source (IOCS) file, stand-alone IOCP disables the dynamic
capability of the IOCS file. (A dynamic IOCS file is one that has been built using the Hardware
Configuration Definition (HCD) or the VM IOCP CMS utility with the DYN option and imported to the hard
disk of the Support Element.) If a dynamic IOCS file is imported from the Hardware Management Console,
from the Hardware Management Console USB Flash Memory Drive, or from an FTP location and not
changed, then the stand-alone IOCP Build program creates an IOCDS that is dynamic capable.

This editor, by itself, does not run any of the steps necessary to generate an IOCDS. Before using the
editor, you can create a source file from one of the following types of data if no card-image exists:

• Card-image data imported from the Hardware Management Console, from the Hardware Management
Console USB Flash Memory Drive, or from an FTP location

• Card-image data recreated by disassembling an IOCDS
• Card-image data copied from another source file

A source file is associated with each IOCDS. If the IOCDS was generated using the Batch IOCP program,
then a Disassemble action must be performed to get the equivalent source file for that I/O configuration.

Using the Editor
When you click the Open Source File action under Options, a window such as that shown in Figure 35 on
page 27 is displayed.

Figure 35. Editing IOCDS card-image data

You cannot save an IOCS that has more records than the maximum permitted. For more information
about the maximum size of an IOCS and how to reduce the size of an IOCS, see “I/O configuration source
files” on page 11.

There are two ways to perform an action:

• Select the icon on the toolbar for the selected text.
• Use a keyboard function key shortcut by entering the key combination.

Select the toolbar icons at the top of the editor window or use the keyboard function key shortcut to
perform the following types of actions:

Save (Ctrl+S) 
Saves the current data without exiting the edit session.

Undo (Ctrl+Z), Redo (Ctrl+Y) 
Undoes the last addition or deletion. Undo is not enabled before you change something.
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If you paste or type in text, selecting the Undo icon one time removes the added text.

Redoes a change on which you have used Undo. Redo is not enabled before you have used Undo.

Bold, Italic, Underscore 
Changes the selected text to bold, italic, or underscore.

Cut (Ctrl+X), Copy (Ctrl+C), and Paste (Ctrl+V) 
Removes selected text, copies selected text, and inserts copied text at the cursor position.

Select All (Ctrl+A) 
Selects all the text in the file.

Find (Ctrl+F) 
Select the Find icon to display the Find/Replace with fields under the toolbar menu.

Enter the Find/Replace with string arguments in the fields and select Find, Replace, or Replace All.
(You can optionally perform a case-sensitive search by selecting Match Case.) The search argument
is highlighted in the file.

Font 
Changes the font for the selected text. Use the drop-down menu to select the font.

Size 
Changes the text size for the selected text. Use the drop-down menu to select the font..

Black background 
Changes the file background to black. Select the Black background icon again to change to the
default background.

Wrap lines 
Allows text to be viewable in the window without horizontal scrolling. Select the Wrap lines again to
change to the default.

Delete Source File
Note: Use this action with extreme care because the IOCS file for the selected IOCDS will be erased. You
are advised to back up the IOCS (using the Export action) before performing this action.

This action erases the I/O configuration source (IOCS) file and replaces it with a minimum default
template IOCS file. Only the IOCS file is deleted. The IOCDS file is not deleted. Selecting Delete Source
File displays the Confirm the Action window. Figure 36 on page 28 shows this window.

Figure 36. Confirm the Action window (for deleting source file)
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A configuration is made up of the IOCDS file and an IOCS file. The IOCS is not required for operation, only
the IOCDS. The IOCS might not always be there, as in the case of a delete or in the case when a batch
IOCP program writes the IOCDS file to the hard disk of the Support Element, which performs the IOCS
delete function automatically.

Print Data Set Report
This action prints or writes to a channel-attached tape drive a formatted report of the IOCDS.

This action reads the selected IOCDS file and prints the I/O configuration reports on the system printer or
writes the formatted reports to a channel-attached tape. The window shown in Figure 37 on page 29
displays the options for Print Data Set Report. If the Data Set Status is not valid, the Print Data Set
Report option is not enabled.

Note: A coupling facility cannot perform the Print Data Set Report action.

Figure 37. Print Data Set Report options

If you click Print to Printer, the Printer Information window is displayed. Figure 38 on page 29 shows
this window. If this attempt is the first attempt to load IOCP code into the targeted logical partition, the
Disruptive Task Confirmation window is displayed. Figure 21 on page 18 shows this window. It warns that
processor program storage in the logical partition will be overlaid and provides an escape. The targeted
logical partition must be activated and have I/O Configuration Control Authority enabled through its
activation profile.

Figure 38. Printer Information window

1. In the Printer address field, enter the device number of the printer that is to print IOCP messages and
reports.

Note: The output printer that you specify in this display window must be a channel-attached device
and must be in the current IOCDS that you selected at power-on reset and must be available to the
logical partition you are using to run IOCP. The output printer must be initialized (print/forms buffer
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must be loaded) before you run IOCP. While running the configuration program, assign exclusively to
the program any devices and control units that IOCP uses. (Other systems should not share the
devices and control units.)

2. In the Lines per page field, enter the maximum number of lines that you want on an output page (you
can specify a maximum of 99). The default is 55. (IOCP uses a value of 20 if you specify a value less
than 20.)

If you click Write Report to Tape, the Write Report to Tape window is displayed. Figure 39 on page 30
shows this window.

Figure 39. Write Report to Tape window

If this attempt is the first attempt to load IOCP code into processor storage, a Disruptive Task
Confirmation window is presented. Figure 21 on page 18 shows this window. It warns that processor
program storage will be overlaid and provides an escape.

1. In the Tape drive address field, enter the device number of the tape device that is to receive the
formatted I/O configuration reports.

Note: The tape drive that you specify in this display window must be a channel-attached device and
must be defined in the current IOCDS that you selected at power-on reset and must be available to the
logical partition you are using to run IOCP. The tape must be able to be manually mounted on the drive
(for example, IOCP does not support tape library systems). IOCP writes the report with records that
have a length of 133 bytes (where the first character is an ANSI carriage control character) and blocks
that are 1330 bytes long.

2. In the File number field, enter the number of the physical file on the tape (such as 1, 2, or 3) where
you want to store the file. IOCP issues a Rewind command followed by forward space file commands
to move the tape to the requested file.

3. In the Lines per page field, enter the maximum number of lines to include per page of the I/O
configuration report (you can specify a maximum of 99). The default is 55. (IOCP uses a value of 20 if
you specify a value less than 20.)

4. Click OK.

Build Data Set
The Build Data Set action:

• Processes the source file data for the selected I/O configuration
• Checks the syntax and validates the configuration
• Generates an IOCDS and, if there are no errors, writes the IOCDS to the hard disk of the Support

Element
• Writes the I/O configuration source (IOCS) file to the hard disk of the Support Element with any IOCP

messages embedded in the file

To create an IOCDS file, click the Build Data Set action on the Input/Output Configuration window. Doing
so displays the Build Configuration window. Figure 20 on page 17 shows this window.
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Figure 40. Build Configuration window

From this window:

1. To print the output, select Send output to a printer.
2. In the Printer address field, enter the device number of the printer that is to print IOCP messages and

reports.

Note: The output printer that you specify in this display window must be a channel-attached device
and must be in the current IOCDS that you selected at power-on reset and must be available to the
logical partition you are using to run IOCP. The output printer must be initialized (print/forms buffer
must be loaded) before you run IOCP. While running the configuration program, assign exclusively to
the program any devices and control units that IOCP uses. (Other systems should not share the
devices and control units.)

3. In the Lines per page field, enter the maximum number of lines that you want on an output page (you
can specify a maximum of 99). The default is 55. (IOCP uses a value of 20 if you specify a value less
than 20.)

4. Clear the Continue printing if data errors occur option to cause the printer to stop if a data check
occurs during printing.

At the first attempt to load IOCP code into the targeted logical partition (for example, for the Print Data
Set action), the Disruptive Task Confirmation window shown in Figure 21 on page 18 is displayed. This
window warns that processor program storage in the logical partition will be overlaid and provides an
escape. The targeted logical partition must be activated and have I/O Configuration Control Authority
enabled through its activation profile.

The completion of the build is reported in one of three ways:

• Successful
• Warnings (see Figure 42 on page 32)
• Errors (see Figure 43 on page 32)

The Input/output (I/O) Configuration Progress window (see Figure 41 on page 31) is displayed,
indicating the steps being processed. The system is then reset, the stand-alone IOCP is loaded into
storage, and IOCP is started using a program status word (PSW) restart. Certain error, warning, or
informational messages might also be displayed to assist you with the build.

Figure 41. Input/output (I/O) Configuration Progress window
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If the build was successful and there are no caution or warning messages, the resultant IOCDS has been
written to the hard disk of the Support Element.

If the build was successful but had caution or warning messages, the window shown in Figure 42 on page
32 is displayed. The resultant IOCDS has been written to the hard disk of the Support Element. Use the
Open Source File action, described in “Open Source File” on page 26 to correct the caution and warning
conditions, if necessary.

Note: A dynamic I/O configuration source (IOCS) file is an IOCS file that has been built using the
Hardware Configuration Definition (HCD) or the VM IOCP CMS utility with the DYN option and imported to
the hard disk of the Support Element. If you edit a dynamic IOCS file, stand-alone IOCP disables its
dynamic capability of the IOCS file.

Figure 42. Input/output Configuration Progress - Build with cautions or warnings

If the build was not successful, an error message is displayed, as shown in Figure 43 on page 32, and
the resultant IOCDS is not written to the hard disk of the Support Element.

Figure 43. Input/output (I/O) Configuration Progress - Build with errors

The caution, warning, and error messages are embedded in the I/O configuration source (IOCS) file at the
line where the condition was detected. To correct the condition, go to the editor by clicking the Open
Source File action on the Input/Output Configuration window. IOCP messages are displayed in the editor
as comments. The messages begin with *ICP in column 1, followed by the IOCP message. IOCP
messages are explained in the Input/Output Configuration Program User's Guide, SB10-7172. It is not
necessary to remove the messages from the file. IOCP removes the messages when the conditions are no
longer detected. If you have changed the IOCS file on the Support Element and have built a new IOCDS on
the hard disk of the Support Element, an inconsistency might occur between the operating system
configuration and the I/O configuration in the newly built IOCDS.

• If you change the hardware configuration with the stand-alone version of IOCP and you use an z/OS or
z/OS.e system, or if you use a VM system with which you have chosen to use HCM and HCD, make the
same changes using HCM or HCD and rewrite the IOCDS before performing the power-on reset. These
actions ensure consistency between the software and hardware configurations and allow the CPC to
perform dynamic I/O configuration.

• If you change the hardware configuration with the stand-alone version of IOCP and you use a VM
system but do not use HCM and HCD, make the appropriate changes, if any, to the VM system before
performing the power-on-reset. If VM cannot sense all the device changes in the hardware
configuration during initial program load (IPL), modify the real I/O configuration file and regenerate your
operating system; or modify the system configuration file and re-IPL your operating system. This action
ensures consistency between the software and hardware configurations. (The real I/O configuration file
is HCPRIO. The system configuration file is SYSTEM CONFIG.)
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Note: For a dynamic-capable system, you must rewrite the IOCDS from VM using the DYN option and
perform a power-on reset.

• For a VSE system, if you change the hardware configuration with stand-alone IOCP, update the software
configuration to reflect the changes (modify the ASI Procedure file). This action ensures consistency
between the software and hardware configurations.

IOCP removes some messages, if necessary, to prevent the I/O configuration source (IOCS) from
exceeding the maximum supported IOCS file size for IOCS files on the hard disk of the Support Element.
For more information about the maximum size of an IOCS and how to reduce the size of an IOCS, see “I/O
configuration source files” on page 11.

Disassemble Data Set
This action generates the card-image statements (source file) from an IOCDS file on the hard disk of the
Support Element and writes a new source file.

Use this action to read an IOCDS from the hard disk on the Support Element and create an I/O
configuration source file (IOCS). IOCP reads the IOCDS, converts it into an IOCS file then writes the file to
the hard disk of the Support Element. The IOCS contains the full configuration described in the original
customer input file, and is the logical equivalent of the card input deck. The IOCS might not look as it did
in the original. Because IOCP does not save comments, the comments are not present in the source file. If
the Data Set Status is invalid, the Disassemble Data Set option is not enabled.

If this attempt is the first attempt to load IOCP code into the targeted logical partition, the Disruptive Task
Confirmation window (shown in Figure 21 on page 18) is displayed. This window warns that processor
program storage in the logical partition will be overlaid and provides an escape. The targeted logical
partition must be activated and have I/O Configuration Control Authority enabled through its activation
profile.

Exit
Click Exit to leave the I/O configuration program.

Using the I/O configuration program View actions
Clicking View on the Input/Output Configuration window displays a list of actions. Figure 44 on page 33
shows this window. Use the actions under View to see what is written in the selected IOCDS file. Select
the action to perform by clicking it or by moving the cursor and clicking Enter.

Note: The information displayed using View is read directly from the IOCDS file, not the source.

Figure 44. Input/Output Configuration - View actions

The actions under View include:
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• Channel Path Configuration
• Function ID Configuration
• Partition Images Configured
• Dynamic Information
• Configuration Program Level
• Supported I/O Mask

Note: All View actions are performed on the Support Element and do not require the stand-alone IOCP
code to be loaded and run in a logical partition, and they do not require an activated partition and power-
on reset of the CPC.

Channel Path Configuration
Channel Path Configuration displays information that defines channel paths in the selected input/output
(I/O) configuration. If the data set status is not valid, the Channel Path Configuration option is not
enabled.

Selecting Channel Path Configuration displays the Channel Path Configuration window. Figure 45 on
page 34 shows this window.

Figure 45. Channel Path Configuration window

Choices include:

• Channel Subsystem Information
• CHPID Information
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• Control Unit Information
• Device Information
• Image Candidate List
• Image Access List

Channel Subsystem Information

Selecting Channel Subsystem Information displays the logical channel subsystem information for the
selected channel in the Channel Subsystem Information window.

Figure 46. Channel Subsystem Information window

CHPID Information

Click CHPID Information to display the channel path identifier information for the selected channel in the
CHPID Information window.

When a channel path is spanned to multiple CSSs, the Channel Subsystem Selection window is displayed,
as shown in Figure 47 on page 35. Select a CSS for the channel path.

Figure 47. Channel Subsystem Selection window

To view logical partition information for a shared or reconfigurable (REC) channel path, see “Image
Candidate List” on page 39 and “Image Access List” on page 39.

Figure 48 on page 36 shows the CHPID Information window that is displayed for coupling over
InfiniBand or ICA SR channels if they exist in the IOCDS.

Chapter 2. Understanding the stand-alone version of IOCP  35



Figure 48. CHPID Information window for coupling over InfiniBand or ICA SR channels

Figure 49 on page 36 shows the CHPID Information window for all channels except coupling over
InfiniBand or ICA SR.

Figure 49. CHPID Information window for channels except coupling over InfiniBand or ICA SR channels

Control Unit Information and Device Information

Selecting Control Unit Information or Device Information on the View menu of the Channel Path
Configuration window displays the control units and devices for a channel path. Control unit and device
information is displayed on a per path basis. A path is the combination of logical channel subsystem
(CSS), CHPID, link address, and control unit logical address (CUADD). Therefore, if the channel path you
select has configured to it more than one CSS, link address, or control unit logical address on a link
address, you must select a unique path. Select a single one of each of these path components in the
windows that are displayed.

When a channel path is spanned to multiple CSSs, the Channel Subsystem Selection window is displayed,
as shown in Figure 47 on page 35 . Select a CSS for the channel path.

When a channel path has multiple control units with different link addresses, the Select a Link Address
window is displayed, as shown in Figure 51 on page 37. This window displays all the link addresses
defined in the selected IOCDS for the selected channel path. Select the specific link address for which you
want control unit or device information to be displayed.
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Figure 50. Select a Link Address window (IBM Z)

Figure 51. Select a Link Address window (IBM zEnterprise System, System z10, and System z9)

Figure 52 on page 38 shows the Control Unit Information window. To display this window, click View >
Control Unit Information on the Channel Path Configuration window (see Figure 45 on page 34). If
necessary, select a unique CSS and link address for the selected channel path. The Control Unit
Information window displays all the control units associated with the selected path (CSS.CHPID.LINK).
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Figure 52. Control Unit Information window

Figure 53 on page 38 shows the Select Control Unit window. This window is displayed when you click
View > Device Information on the Channel Path Configuration window (see Figure 45 on page 34) and
the selected path (CSS.CHPID.LINK) has multiple control unit logical addresses (CUADDs). The Select
Control Unit window displays all the control units associated with the selected path. Select the control
unit or CUADD for which you want to display device information.

Figure 53. Select Control Unit window

Figure 54 on page 39 shows the Device Information window. This window is displayed when you click
View > Device Information on the Channel Path Configuration window (see Figure 45 on page 34) and, if
necessary, select a unique CSS, link address, and control unit logical address (CUADD) for the selected
channel path. The Device Information window displays all the devices associated with the selected
control unit and path (CSS.CHPID.LINK.CUADD).
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Figure 54. Device Information window

Image Candidate List

To display the Image Candidate List window, on the Channel Path Configuration window (see Figure 45 on
page 34), select View > Image Candidate List. When a channel path is spanned to multiple CSSs, the
Channel Subsystem Selection window is displayed (see Figure 47 on page 35). Select a CSS for the
channel path. The Image Candidate List window displays a list of logical partitions that have authority to
access the channel path.

Figure 55. Image Candidate List window

Image Access List

To display the Image Access List window on the Channel Path Configuration window (see Figure 45 on
page 34), select View > Image Access List. When a channel path is spanned to multiple CSSs, the
Channel Subsystem Selection window is displayed, as shown in Figure 47 on page 35. Select a CSS for the
channel path. The Image Access List window displays the logical partitions that have access to the
channel path at logical partition activation following the initial power-on reset of the IOCDS.
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Figure 56. Image Access List window

Function ID Configuration
The Function ID Configuration window displays information that defines PCI functions in the selected
input/output (I/O) configuration. A function ID (FID) indicates a native PCI function identifier. This is a
hexadecimal integer of model-dependent length where the value must be unique in the IOCDS. The
PCHID is a hexadecimal integer that indicates the physical channel path (for example, the physical
adapter associated with the PCI Function ID). Depending on the adapter type, one or more PCI functions
may be specified with the same PCHID. If the adapter supports sharing, one or more Function IDs are
defined on a PCHID up to an adapter-specific limit. A virtual function (VF) identifier must be defined for
each Function ID on a shared adapter. The value of this is a decimal integer with a value of 1 up to an
adapter-specific limit and this value must be unique for a given PCHID and PORT. If a PCI Function is
unshared, there can only be one PCI Function defined for a PCHID and no virtual function can be
specified. The Access Partition Name is the logical partition that has access to the FID following the initial
power-on reset of the IOCDS.

Selecting View>Function ID Configuration displays the Function ID Configuration window.

Figure 57. Function ID Configuration

You can work with the Function ID Configuration table by using the table icons or Select Action from the
table tool bar.
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Figure 58. Function ID Configuration actions

Image Candidate List
Displays a list of logical partitions that have authority to access the Function ID.

If you place your cursor over an icon, the icon description appears. The icons perform the following
functions:

Show Filter Row
Displays a row under the title row of the table. Select Filter found under a column title to define a
filter for that column. This limits the entries in the table. Tables can be filtered to show only those
entries most important to you. Click OK when you have defined your filter. The filtered view can be
toggled on and off by selecting the check box next to the desired filter in the filter row. If you no
longer want the Filter row to appear, click Hide Filter Row.

Clear All Filters
Returns the table back to the complete listing.

Edit Sort
Performs multi-column sorts of objects in the table in ascending or descending order. Click Edit Sort
to define sorts for columns in a table. Alternatively, single column sorting can be performed by
selecting the ^ in the column header to change from ascending to descending order.

Clear All Sorts
Returns the table back to the default order.

Configure Columns
Allows you to select which columns you want displayed. Arrange the columns in the table in a desired
order or hide columns from view. All available columns are listed in the Columns list box by their
column name. You select the columns you want displayed or hidden by checking or unchecking the
list box and using the arrow buttons to the right of the list to change the order of the selected column.

Image Candidate List

To display the Image Candidate List window from the Function ID Configuration window (see “Function ID
Configuration” on page 40), select Image Candidate List from the drop-down list. The Image Candidate
List window displays a list of logical partitions that have authority to access the Function ID.
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Figure 59. Image Candidate List

Partition Images Configured
Partition Images Configured displays the channel subsystems, MIF image ID numbers, and names of
logical partitions supported by the selected input/output (I/O) configuration. If the data set status is
invalid, the Partition Images Configured option is not enabled.

Selecting View> Partition Images Configured displays the names of all the partitions defined in the
selected IOCDS.

Figure 60. Partition Images Configured window

Dynamic Information
Dynamic Information displays the current channel subsystem hardware system area (HSA) token, the
token of the selected input/output configuration data set (IOCDS), and the maximum number of devices
in the IOCDS and in HSA. If the data set status is invalid, the Dynamic Information option is not enabled.

Selecting View>Dynamic Information displays data pertaining to the selected IOCDS.
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Figure 61. Dynamic Information window

The Data set token field displays the token information contained in the I/O configuration data set
(IOCDS) selected. A Hardware system area token is displayed only if the system has been power-on
reset using an IOCDS that had a token in it. (The token was built by the HCD tool in z/OS, z/OS.e, or VM or
the VM IOCP CMS utility option DYN was specified.)

If any dynamic I/O configuration changes have been made, the hardware system area token displayed is
the current token and not the token from the power-on reset.

The Data set maximum number of devices displays the maximum number of devices for each logical
channel subsystem and subchannel set defined in the selected IOCDS. The Hardware system area
maximum number of devices is displayed only if the system has been power-on reset using an IOCDS
that had a token in it and the power-on reset enabled dynamic I/O configuration.

Configuration program Level
Input/Output Configuration Program (IOCP) Level window displays the version, release, and level of the
Licensed Machine Code (LMC) for the stand-alone Input/Output Configuration Program (IOCP) on this
Support Element.

The Configuration Program Level is the current level of the stand-alone IOCP on the Support Element.

Figure 62. Input/Output Configuration Program (IOCP) level window

Supported I/O Mask
Figure 63 on page 44 shows the Supported I/O Mask window. To display this window, on the Channel
Path Configuration window (see Figure 45 on page 34), click View > Supported I/O Mask. (If the data set
status is invalid, the Supported I/O Mask is not enabled.)

Supported I/O Mask displays the hexadecimal values that identify the CPC functions or channel path
types. It identifies the functions and channel path types that the machine supports.

The Supported I/O Mask window displays several lines. The IOCDS Supported I/O mask identifies the
functions and channel path types defined in the selected IOCDS. If the IOCDS mask contains a value not
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in the Machine Supported I/O mask, then a third line is displayed in the window for the unsupported
items. The Unsupported mask items line displays the items that the machine does not support. The
machine cannot perform a power-on reset with this IOCDS (error message ACTZ16F results).

See the information concerning CPC activation and power-on reset error in the Input/Output Configuration
Program User's Guide, SB10-7172, for a description of the supported functions and channel types.

Figure 63. Supported I/O Mask window

IOCP wait state codes

Enabled wait states

When the stand-alone version of IOCP is running, the central processor enters many enabled wait states
(PSW bit 7 is on). These are normal conditions while IOCP waits for the Support Element to respond to
IOCP requests such as a read or write of an IOCDS. If the central processor stays in an enabled wait state
for more than 10 minutes, unless it is waiting for operator input on a console, the Support Element is
busy. You can either wait for the Support Element to finish or click Cancel and restart IOCP at a later time.
If the problem persists, contact the service representative.

Disabled wait states

While the stand-alone version of IOCP is running, IOCP issues the following disabled wait state codes
when the indicated conditions occur. (The z/OS, z/OS.e, VM, and VSE versions of IOCP do not issue wait
state codes.) Wait State codes are hexadecimal and are stored in the low-order bytes of the address area
of the PSW.

B20

Explanation

The operator who is running the stand-alone version of
IOCP has started IOCP processing after the IOCP
function has completed, or IOCP was unable to read
from the Support Element the selected function to
perform.

Operator response

If IOCP completed the selected function, no action is
required. Otherwise, notify your system programmer.

Problem determination

If IOCP did not complete the selected function, save
all associated output. Contact the service
representative.

B21

Explanation

A program-check interruption occurred while the
stand-alone version of IOCP was running.

Operator response

Notify your system programmer.

Problem determination

Save all associated output. Contact the service
representative.

B22

Explanation

A machine-check interruption occurred while the
stand-alone version of IOCP was running.

Operator response

Notify your system programmer.
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Problem determination

Save all associated output. Contact the service
representative.

B23

Explanation

An uncorrectable I/O error occurred while the stand-
alone version of IOCP was running.

Operator response

Notify your system programmer.

Problem determination

Save all associated output. Contact the service
representative.

B24

Explanation

While the stand-alone version of IOCP was running,
IOCP encountered an error in the Support Element and
cannot communicate with the person operating IOCP.

Operator response

Notify your system programmer.

Problem determination

Save all associated output. Contact the service
representative.
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Chapter 3. Running the stand-alone version of IOCP

Preparing for system installation
The IOCS contains specific data about all attached control units and I/O devices. An IOCS file must
contain ASCII data. When importing from diskette (for System z10 or System z9), it must either be in DOS
file format or have been compressed. If the file is compressed, it must contain a single IOCS file. The
IOCS file name must have a maximum of eight characters and the file extension must have a maximum of
3 characters. When importing from USB flash memory drive, the IOCS file can be in VFAT or DOS file
format or have been compressed.

The IOCS is the input to the I/O configuration program (IOCP). The IOCP loads the IOCS into the central
processor and uses it to build the I/O configuration data set (IOCDS).

Note: If you are upgrading to an IBM Z, IBM zEnterprise, System z10, or System z9 you can specify
CHECKCPC=NO in the PARM parameter of the EXEC statement for IOCP on z/OS, z/OS.e, and VSE or
specify CMS option NOCHKCPC for IOCP on VM. You can use these options to write the IOCDS for your
new CPC to your current CPC before the upgrade. Inform the service representative which IOCDS to use
after the upgrade.

If the I/O configuration source is available at installation time…
If the I/O configuration source file (IOCS) has been previously prepared, then you can begin the
procedure of importing it to the Support Element and generating an IOCDS. Follow the steps provided in
“Building an input/output configuration data set” on page 47.

If the I/O configuration source is not available at installation time…
If no I/O configuration source file (IOCS) is available, then you must create one at installation time. The
Input/Output Configuration Program User's Guide, SB10-7172, provides instructions on the card-image
format and syntax.

Note: If the I/O Configuration Source is not Available, Installation Time is increased significantly.

Creating an I/O configuration source (IOCS) file
If the source is to be saved on diskette (for System z10 or System z9) or USB flash memory drive, you can
use any personal computer or equivalent, with DOS or an equivalent ASCII file editor to create the file.
You can also use the stand-alone IOCP editor on the Support Element to input the I/O definition.
Procedures for using the Support Element editor are found in “Creating an IOCDS in a new CPC” on page
51.

If a default or old source file exists, you can use the Delete Source File action to clear the file or use the
editor actions to delete the contents of the selected source file rather than creating one from scratch.
Procedures are found in “Updating an IOCDS using the card-image input editor” on page 53.

For I/O configuration examples, see the Input/Output Configuration Program User's Guide, SB10-7172.

After creating an I/O configuration source (IOCS) file, go to “Building an input/output configuration data
set” on page 47.

Building an input/output configuration data set
If an I/O configuration source file has been prepared on a USB flash memory drive, then proceed with the
following tasks:

1. Perform a power-on reset with any IOCDS. (See“Power-on reset for IOCDS build” on page 48)
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2. Activate a logical partition where the IOCP will be run. The logical partition must be activated with I/O
Configuration Control Authority enabled through its activation profile. (See “Activating a partition” on
page 8)

3. Select the activated partition and then select the Input/Output (I/O) Configuration task. (See
“Starting the IOCP program” on page 9)

4. If the I/O configuration source file is not yet on the Support Element, import it. (See “Import an I/O
configuration source file” on page 48)

5. Build the IOCDS. (See “Build the IOCDS” on page 50)
6. Perform a power-on reset with the new IOCDS.

Power-on reset for IOCDS build
Perform a power-on reset using Steps “1” on page 5 through “3” on page 7.

Important!

To change a Write-Protected data set, select the data set, and then click Options> Disable Write
Protection.

Import an I/O configuration source file
If you have the input file on a USB flash memory drive, follow these steps:

Note: The steps for importing a source file from a USB flash memory drive on the Hardware Management
Console are like the steps for importing a source file from a Hardware Management Console diskette (for
System z10 or System z9) or from an FTP location.

1. From the Hardware Management Console workplace window, log on the Support Element using the
Single Object Operations task. (See “Logging on the Support Element” on page 2 for the steps to
perform this task.)

2. From the Support Element workplace window, start the Input/Output (I/O) Configuration task. (See
“Starting the IOCP program” on page 9 for the steps to perform this task.) The Input/Output
Configuration window is displayed. Figure 64 on page 48 shows this window. 

Figure 64. Input/Output Configuration window
3. Select any data set that is not write protected. Click Options. The Import Source File selection is

displayed. Figure 65 on page 49 shows this window.

Note: The data set you select is replaced by the file you import.
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Figure 65. Options expanded
4. Point to Import Source File, and then click Hardware Management Console USB Flash Memory

Drive. Figure 66 on page 49 shows the window including these choices. 

Figure 66. Input/Output Configuration window with Options and Import Source File menu items

The Import from HMC USB Flash Memory Drive window is displayed. Figure 67 on page 49 shows this
window. 

Figure 67. Import from HMC USB Flash Memory Drive window

Note: The active selection depends on if you are operating from the Support Element or the Hardware
Management Console.

Chapter 3. Running the stand-alone version of IOCP  49



5. Select the file name and extension of the source file; then click OK. The Input/Output Configuration
window with a message about the success of the import is displayed. Figure 68 on page 50 shows
this window. 

Figure 68. Input/Output Configuration success window

Build the IOCDS
1. From the Input/Output Configuration window, click Options and then Build Data Set. The Disruptive

Task Confirmation window is displayed for the first build only. Figure 69 on page 50 shows this
window. 

Figure 69. Disruptive Task Confirmation window

If you want to continue with the action, type the password for the specified user role and click Yes. If
you do not want to continue with the action, click No. If you choose to continue, the Build
Configuration window is displayed. Figure 70 on page 51 shows this window. 
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Figure 70. Build Configuration window
2. Select the appropriate parameters; then click OK. You can optionally select Send output to a printer.

Note: Selection is indicated by a check mark in the check box. You can select more than one box or
none at all.

The Input/Output (I/O) Configuration Progress window is displayed while the IOCP program runs. The
run can take up to 12 minutes. Status messages are displayed to indicate the progress of the IOCDS
build. The program completes, and a final IOCP status message is displayed that states whether the
build was successful (see the IOCP messages that follow).

• If the build is successful, one of the following messages is displayed:
ICP500A: PROCESSING COMPLETED. CHECK PRINTER FOR LISTING OR RETURN TO EDITOR.
ICP500A: ICP501A: PROCESSING COMPLETED. NO PRINTER SPECIFIED-NO LISTING. PROCEED.

• For cautions or warnings, the following message is displayed:
ICP502A: PROCESSING COMPLETED BUT HAS MESSAGE(S), RETURN TO EDITOR.

• If errors are found, one of the following messages is displayed:
ICP506A: CARD INPUT ERROR(S) FOUND, RETURN TO EDITOR.
ICP507A: IOCDS GENERATION ERROR, RETURN TO EDITOR.

The IOCP messages are embedded in the source file at the line where the condition was detected. Use
the Open Source File action to correct the condition. For an example of some typical errors, see
Appendix B, “Resolving IOCP errors,” on page 57. For more detailed error information, see Input/
Output Configuration Program User's Guide, SB10-7172.

3. Click OK. The Input/Output Configuration window is displayed.
4. Do one of the following:

• If you have more data sets to install, go to back to Step “3” on page 48.
• If you do not have more data sets to install, close the Input/Output Configuration window, and go to

“Power-on reset to enable the IOCDS” on page 51.

Power-on reset to enable the IOCDS
From the Support Element workplace, perform a power on reset. See “Performing a power-on reset” on
page 5 for the steps.

Creating an IOCDS in a new CPC
All IOCDS source data consists of RESOURCE, FUNCTION, CHPID, CNTLUNIT, and IODEVICE statements.
The ID statement is optional. All logical partitions, functions, channel paths, control units, and I/O devices
must be defined in the source file to generate an I/O configuration data set (IOCDS), which can then be
used to power-on reset the CPC.

Perform the steps that create an IOCP configuration source file as part of the installation procedure for a
new CPC.
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The following example assumes that the card-image statement source deck must be entered from
scratch. All of the I/O channel paths, control unit, and installed device unit addresses must be defined
and available. When the input file is created, it defines the initial I/O configuration for the new CPC.
Comments are saved.

To create an IOCDS for a new CPC, perform the following steps on the Support Element of the CPC:

1. Perform a power-on reset of the system with the D0 IOCDS.
2. Activate a partition.
3. From the Support Element workplace window initiate the Input/Output (I/O) Configuration task. If

necessary, see the procedure described in “Controlling the program” on page 15.
4. Select the IOCDS to be created
5. Use the Delete Source File action under the Options action on the Input/Output Configuration window

to remove the existing source file for the selected configuration. (If there is a default or example
source, check with the source owner to determine whether to save the source by using the Export
Source File action to move the file to a diskette (for System z10 or System z9)).

6. Use the Open Source File action under the Options action to edit the new source file. Add the
statements for the channel paths, control units, and I/O devices. To ensure that you have included in
the IOCP statements all of the I/O devices of your system, make a drawing of the physical
arrangement of control units and attached devices to show all channel connections.

• The editor description begins at “Open Source File” on page 26.

Note: All text must be in uppercase.
• For format and syntax of the IOCP statements, see the section on IOCP statements and functions in

the Input/Output Configuration Program User's Guide, SB10-7172.
• Observe the following hints:

– Enter the ID statement first. The first eight characters of the

MSG1=

parameter are the IOCDS name displayed on the Support Element when the IOCDS is built.
– Enter the RESOURCE statement next. Define each logical partition and channel subsystem (CSS)

in your configuration.
– Enter the CHPID statements. Define each physical channel path installed on your system.
– Enter the CNTLUNIT statements. It is crucial to match the

PROTOCL=

and

UNITADD=

parameters with the values set in each control unit by the system installer.
– Enter the IODEVICE statements.
– Enter the FUNCTION statements.

After completing the input, save the edited file and exit the editor.
7. Select the Build Data Set action to generate the system IOCDS. When successfully completed, the

IOCDS is written to the Support Element and saved on the hard disk. If the build is not successful,
IOCP error messages are inserted in the card-image statements, and a copy is saved on the hard disk
of the Support Element. Return to the editor to correct the errors.

8. Exit the Input/Output Configuration window.
9. Perform a power-on reset of the system with the IOCDS written in Step “7” on page 52. Select the

newly created IOCDS in the power-on reset window.
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Updating an IOCDS using the card-image input editor
This procedure describes how to update the I/O configuration data in an IOCDS for an installed CPC.

To update the I/O configuration for a CPC:

1. Ensure that the CPC is in a power-on reset state with an appropriate existing IOCDS.
2. From the Support Element workplace window initiate the Input/Output (I/O) Configuration task. If

necessary, see the procedure described in “Controlling the program” on page 15.
3. Select the IOCDS to update.
4. Check to see if the source file matches the contents of the IOCDS. (The source status is Verified or

Warnings, and the IOCDS status is Valid when the IOCDS was built from the source). If the status for
the source file and the IOCDS do not match, then the source for the selected IOCDS might be
different from the source used to create the IOCDS. The source file might have been imported from
diskette (for System z10 or System z9) or it might have been modified using the editor. A
reconstructed source can be recreated by selecting the Disassemble Data Set action. The
Disassemble Data Set action reads the selected IOCDS and creates a source file equivalent to the
one used to create the IOCDS.

5. If you are adding (or deleting) I/O in your configuration, then update (Open Source File) the input
deck to reflect any new I/O configured in the CPC.

6. Prepare the system printer if you want printed output. The printer must be initialized (the print/forms
buffer must be loaded).

7. Select the Build Data Set action from the Options menu on the Input/Output Configuration window.

a. Select the appropriate parameters then select Enter.

During the build, IOCP reads the input statements, saves them as card-image data in storage,
checks the syntax, validates it, and generates an IOCDS. It produces configuration reports of the
IOCDS generated. (See the section on IOCP statements and functions in the Input/Output
Configuration Program User's Guide, SB10-7172, for more details.)

Messages are displayed by IOCP to give the status of the IOCDS build.
b. An error message is displayed if IOCP has detected errors in the card-image file. To correct the

errors, select the Open Source File action on the I/O Configuration window after the completion
message is displayed. Errors detected by IOCP are displayed in the editor. Errors are displayed in
the form of IOCP comments that begin with *ICP in column 1, followed by the error message
number and the message text. See the section on IOCP messages in the Input/Output
Configuration Program User's Guide, SB10-7172, for an explanation of the error messages. Correct
the errors in the card-image file. It is not necessary to remove the error messages from the file.
IOCP removes the messages when no errors are detected on subsequent builds.

8. View the generated IOCDS content using the View action (Channel Path Configuration and Device
Information windows) or analyze the configuration reports produced in Step “7.a” on page 53 to
ensure that the I/O configuration that you want has been generated. If you must change the card
images, use the editor to modify the card-image data on the Support Element, and return to the Build
Data Set process (Step 7 on page “7” on page 53).

9. If the input deck is correct, and the build complete, the IOCDS is on the hard disk of the Support
Element.

10. Export the card-image source file to provide a backup if editing was done on the Support Element.
11. Exit IOCP by selecting Options and then Cancel.

The I/O configuration data in the new Ax IOCDS now contains your new configuration. Selecting a
power-on reset, with Ax as the IOCDS parameter, activates the new configuration and makes the Ax
IOCDS the configuration that the channel subsystem uses to control I/O requests. Use the View
action to view the configuration. If necessary, see the procedure described in “Power-on reset for
IOCDS build” on page 48 to perform the power-on reset. Select the IOCDS on the power-on reset
window.
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12. Test the new configuration following the procedures established for your installation.

Notes:

a. If you change the hardware configuration with the stand-alone version of IOCP and you use an
z/OS or z/OS.e system, or if you use a VM system with which you have chosen to use HCM and
HCD, make the same changes using HCM or HCD and rewrite the IOCDS before performing the
power-on reset. These actions ensure consistency between the software and hardware
configurations and allow the CPC to perform dynamic I/O configuration.

b. If you change the hardware configuration with the stand-alone version of IOCP and you use a VM
system but do not use HCM and HCD, make any appropriate changes to the VM system before
performing the power-on reset. If VM cannot sense all the device changes in the hardware
configuration during initial program load (IPL), modify the real I/O configuration file and
regenerate your operating system; or modify the system configuration file and re-IPL your
operating system. This action ensures consistency between the software and hardware
configurations. (The real I/O configuration file is HCPRIO. The system configuration file is SYSTEM
CONFIG.)

For a dynamic-capable processor, you must rewrite the IOCDS from VM using the DYN option and
perform a power-on reset.

c. For a VSE system, if you change the hardware configuration with stand-alone IOCP, update your
software configuration to reflect the changes (modify the ASI Procedure file). This action ensures
consistency between the software and hardware configurations.
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Appendix A. Configuration examples

For more information, see the section on configuration examples in the Input/Output Configuration
Program User’s Guide, SB10-7172.
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Appendix B. Resolving IOCP errors

If errors are found in the IOCP source file when you try to run IOCP, IOCP messages are written in the file
on the lines following the statements with errors. The IOCP messages have identifiers starting with *ICP.
For a description of the messages, see the section on IOCP messages in the Input/Output Configuration
Program User's Guide, SB10-7172. To correct the errors, edit the IOCDS source file. See “Open Source
File” on page 26 for information about editing an IOCDS source file.

You can either scroll through the IOCP source file looking for IOCP messages, or use the search function
in the editor. The most common errors are missing parentheses or commas. Use similar statements
without errors to determine the changes needed to correct the file. Starting at the Input/Output
Configuration window, do the following:

1. Select the IOCP source
2. Click Options>Open Source File.
3. To find the first IOCP, select Edit; click Find; then search for "*ICP"
4. Correct the statement causing the first error indication
5. Press Find Next to search for the next error
6. Continue to correct statements causing error and warning messages
7. When complete, press Ctrl-S to save the changes and try to create the IOCDS again.

Note: If the IOCDS source information is updated, a new IOCDS must be created and the system
activated using the new IOCDS source file. To create the IOCDS, go to the Input/Output Configuration
window, click Options > Build Data Set.

The example shown in “An error example” on page 57 shows an example of a file with incorrect
statements and error messages.

An error example
The following example shows an IOCP source file after an IOCDS build was attempted. The file contains
several syntax errors. The error messages inserted by IOCP are emphasized.

For an explanation of the errors in the file, see “Explanation of errors in example” on page 58.

 RESOURCE PART=(CSS(0),LP01,LP02,LP03,LP04,LP05,LP06)
*
 CHPID PCHID=100,PATH=(CSS(0),00),TYPE=CNC,PART=LP01,SWITCH=30
 CHPID PCHID=101,PATH=(CSS(0),01),TYPE=CNC,PART=LP01,SWITCH=31
 CHPID PCHID=102,PATH=(CSS(0),02),TYPE=CNC,PART=LP01,SWITCH=32
 CHPID PCHID=103,PATH=(CSS(0),03),TYPE=CNC,PART=LP02,SWITCH=33
 CHPID PCHID=104,PATH=(CSS(0),04),TYPE=CNC,PART=LP02,SWITCH=34
 CHPID PCHID=105,PATH=(CSS(0),05),TYPE=CNC,PART=LP02,SWITCH=35
 CHPID PCHID=106,PATH=(CSS(0),06),TYPE=CVC,PART=LP03
 CHPID PCHID=107,PATH=(CSS(0),07),TYPE=CVC,PART=LP03
 CHPID PCHID=108,PATH=(CSS(0),08),TYPE=CBY,PART=LP04
 CHPID PCHID=109,PATH=(CSS(0),09),TYPE=CBY,PART=LP04
 CHPID PCHID=10A,PATH=(CSS(0),0A),TYPE=CNC,PART=LP04
 CHPID PCHID=10B,PATH=(CSS(0),0B),TYPE=CNC,PART=LP05
 CHPID PCHID=10C,PATH=(CSS(0),0C),TYPE=CNC,PART=LP05
 CHPID PCHID=10D,PATH=(CSS(0),0D),TYPE=CNC,PART=LP05
 CHPID PCHID=10E,PATH=(CSS(0),0E),TYPE=CTC,PART=LP06,SWITCH=3E
*
 CNTLUNIT CUNUMBR=100,PATH=(CSS(0),00),UNITADD=((00,4)),UNIT=CNC,      *
               LINK=10
 IODEVICE ADDRESS=1000,CUNUMBR=100,UNIT=CNC,STADET=Y
*
 CNTLUNIT CUNUMBR=101,PATH=(CSS(0),01),UNITADD=(10,4)),UNIT=CNC,       *
               LINK=11

*ICP  ICP114I DELIMITER ERROR, EXPECT LEFT PARENTHESIS - 10,4)),U 
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 IODEVICE ADDRESS=1010,CUNUMBR=101,UNIT=CNC,STADET=Y
*
 CNTLUNIT CUNUMBR=102,PATH=(CSS(0),02),UNITADD=((20,)),UNIT=CNC,       *
               LINK=12

*ICP  ICP125I PARAMETER CONTAINS NON-NUMERIC CHARACTERS - )),UNIT= 

 IODEVICE ADDRESS=1020,CUNUMBR=102,UNIT=CNC,STADET=Y
*
 CNTLUNIT CUNUMBR=104,PATH=(CSS(0),04),UNITADD=((40,4))UNIT=CNC,       *
               LINK=14

*ICP  ICP112I DELIMITER ERROR, EXPECT BLANK OR COMMA - UNIT=CNC 

 IODEVICE ADDRESS=1040,CUNUMBR=104,UNIT=CNC,STADET=Y
*
 CNTLUNIT CUNUMBR=105,PATH=(CSS(0),05),UNITADD=((50,4),UNIT=CNC,       *
               LINK=15

*ICP  ICP114I DELIMITER ERROR, EXPECT LEFT PARENTHESIS - UNIT=CNC 

 IODEVICE ADDRESS=1050,CUNUMBR=105,UNIT=CNC,STADET=Y

Explanation of errors in example
The following corrections are required to make the IOCP source file shown in “An error example” on page
57 build an IOCDS without errors.

First error
Add a left parenthesis to UNITADD - UNITADD=((10,4)),

Second error
Add the correct value to UNITADD - UNITADD=((20,4)),

Third error
Add a comma after UNITADD - UNITADD=((40,4)),UNIT=CNC

Fourth error
Add a right parenthesis to UNITADD - UNITADD=((50,4)),
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Appendix C. Stand-Alone IOCP Support Element
messages

Stand-Alone IOCP Support Element messages
The following messages are displayed by the Support Element (SE) when running various stand-alone
IOCP operations. The Problem Determination in some messages describes the suggested action to
correct the problem.

IQZ1100I LOADING THE STAND-ALONE
IOCP CODE

Explanation

This message indicates that the stand-alone IOCP
program is being transferred from the SE to the system
memory. The program is loaded starting at the logical
partition address zero.

IQZ1101I CANCEL RECEIVED. STOPPING
THE STAND-ALONE IOCP
PROGRAM.

Explanation

This message indicates that the stand-alone IOCP
program operation is being canceled at the request of
the user.

IQZ1102I READING THE CARD-IMAGE
INPUT FILE FROM THE SUPPORT
ELEMENT.

Explanation

This message indicates that the stand-alone IOCP
program is transferring the IOCP source file from the
SE to the system memory.

IQZ1103I READING THE CONFIGURATION
DATA SET FROM THE SUPPORT
ELEMENT.

Explanation

This message indicates that the stand-alone IOCP
program is transferring the IOCDS file from the SE to
the system memory.

IQZ1103I SYNTAX AND VALUE CHECKING
THE CARD IMAGE STATEMENTS.

Explanation

This message indicates that the stand-alone IOCP
program is parsing the IOCP source file in system

memory to perform the necessary checks and
validation.

IQZ1105I PRINTING OR WRITING THE I/O
CONFIGURATION REPORTS.

Explanation

This message indicates that the stand-alone IOCP
program is transferring a formatted report of the
IOCDS from system memory to either a channel
attached printer or a channel attached tape.

IQZ1106I CREATING A CARD-IMAGE INPUT
FILE FROM THE CONFIGURATION
DATA SET.

Explanation

This message indicates that the stand-alone IOCP
program is parsing a selected IOCDS file and is
creating an equivalent source file based on the
contents of the IOCDS file.

IQZ1107I WRITING THE CONFIGURATION
DATA SET TO THE SUPPORT
ELEMENT.

Explanation

This message indicates that the stand-alone IOCP
program is transferring the IOCDS file from system
memory to the Support Element.

IQZ118I WRITING THE CARD-IMAGE
INPUT FILE TO THE SUPPORT
ELEMENT.

Explanation

This message indicates that the stand-alone IOCP
program is transferring the IOCP source file from the
system memory to the Support Element.

IQZ1109I PREPARING THE ENVIRONMENT
FOR IOCP LOAD. (SYSTEM RESET
CLEAR)
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Explanation

This message indicates that the stand-alone IOCP
program is requesting a "system reset clear" for the
targeted logical partition.

IQZ1110I READING THE CARD-IMAGE
INPUT FILE FROM CHANNEL
ATTACHED TAPE.

Explanation

This message indicates that the stand-alone IOCP
program is transferring the IOCP source file from a
channel attached tape to the system memory.

IQZ1111I WRITING THE CARD-IMAGE
INPUT FILE TO CHANNEL
ATTACHED TAPE.

Explanation

This message indicates that the stand-alone IOCP
program is transferring the IOCP source file from
system memory to a channel attached tape.

IQZ1052A INVALID DATA IN THE STAND
ALONE CONTROL BLOCK FIELD =
%1 CONTENT=%2 HEX. IOCP
TERMINATED.

Explanation

This message indicates an error condition.

IQZ10531 AN INTERNAL ERROR HAS
OCCURRED. STAND ALONE IOCP
CANNOT PROCEED.

Explanation

This message indicates an error condition.

Problem determination

Check your selections and entry field data, and then
retry the operation. If the failure persists, contact your
service representative.

IQZ1054I THE PROCESSOR IS NOT
OPERATIONAL.

Explanation

The stand-alone IOCP cannot run unless the machine
is powered on and the targeted Processing Unit is
operational.

Problem determination

Perform a POR to make the Processing Unit
operational. If a POR cannot be performed, contact
your service representative.

IQZ10551 THE SYSTEM IS NOT POWERED-
ON.

Explanation

The stand-alone IOCP cannot run unless the machine
is powered on and in a POR complete state.

Problem determination

Perform a POR to make the Processing Unit
operational. If a POR cannot be performed, contact
your service representative.

IQZ1056I THE SYSTEM IS NOT IN A
POWER®-ON-RESET STATE.

Explanation

The stand-alone IOCP cannot run unless the machine
is powered on and in a POR complete state.

Problem determination

Perform a POR to make the Processing Unit
operational. If a POR cannot be performed, contact
your service representative.
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Appendix D. Notices

This information was developed for products and services offered in the US.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprise is
entirely coincidental.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks of International Business Machines Corp., registered in
many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other
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companies. A current list of IBM trademarks is available on the web at "Copyright and trademark
information" at http://www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, and Windows logo are trademarks of Microsoft Corporation in the United States,
other countries, or both.

Class A Notices
The following Class A statements apply to this IBM product. The statement for other IBM products
intended for use with this product will appear in their accompanying manuals.

Federal Communications Commission (FCC) Statement

Note: This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. IBM is not responsible for any radio or television interference caused by using other than
recommended cables and connectors or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Compliance Statement

This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité à la réglementation d'Industrie Canada

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

European Community Compliance Statement

This product is in conformity with the protection requirements of EU Council Directive 2014/30/EU on the
approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A Information Technology
Equipment according to European Standard EN 55032. The limits for Class A equipment were derived for
commercial and industrial environments to provide reasonable protection against interference with
licensed communication equipment.

European Community contact:
IBM Deutschland GmbH
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Technical Regulations, Department M372
IBM-Allee 1, 71139 Ehningen, Germany
Tele: +49 (0) 800 225 5423 or +49 (0) 180 331 3233
email: halloibm@de.ibm.com

Warning: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

VCCI Statement - Japan

The following is a summary of the Japanese VCCI statement above:

This is a Class A product based on the standard of the VCCI Council. If this equipment is used in a
domestic environment, radio interference may occur, in which case the user may be required to take
corrective actions.

Japan JIS C 61000-3-2 Compliance

For products less than or equal to 20 A per phase, the following statement applies:

For products greater than 20 A, single-phase, the following statements apply:

For products greater than 20 A per phase, three-phase, the following statements apply:
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Electromagnetic Interference (EMI) Statement - People's Republic of China

Declaration: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user may need to perform practical action.

Electromagnetic Interference (EMI) Statement - Taiwan

The following is a summary of the Taiwan EMI statement above:

Warning: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user will be required to take adequate measures.

IBM Taiwan Contact Information:
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Electromagnetic Interference (EMI) Statement - Korea

Germany Compliance Statement

Deutschsprachiger EU Hinweis: Hinweis für Geräte der Klasse A EU-Richtlinie zur
Elektromagnetischen Verträglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2014/30/EU zur Angleichung der
Rechtsvorschriften über die elektromagnetische Verträglichkeit in den EU-Mitgliedsstaaten und hält die
Grenzwerte der EN 55032 Klasse A ein.

Um dieses sicherzustellen, sind die Geräte wie in den Handbüchern beschrieben zu installieren und zu
betreiben. Des Weiteren dürfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
übernimmt keine Verantwortung für die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung von IBM verändert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung von IBM gesteckt/eingebaut werden.

EN 55032 Klasse A Geräte müssen mit folgendem Warnhinweis versehen werden:

"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im Wohnbereich Funk-
Störungen verursachen; in diesem Fall kann vom Betreiber verlangt werden, angemessene Maßnahmen
zu ergreifen und dafür aufzukommen."

Deutschland: Einhaltung des Gesetzes über die elektromagnetische Verträglichkeit von Geräten

Dieses Produkt entspricht dem "Gesetz über die elektromagnetische Verträglichkeit von Geräten
(EMVG)". Dies ist die Umsetzung der EU-Richtlinie 2014/30/EU in der Bundesrepublik Deutschland.

Zulassungsbescheinigung laut dem Deutschen Gesetz über die elektromagnetische Verträglichkeit
von Geräten (EMVG) (bzw. der EMC EG Richtlinie 2014/30/EU) für Geräte der Klasse A

Dieses Gerät ist berechtigt, in Übereinstimmung mit dem Deutschen EMVG das EG-Konformitätszeichen -
CE - zu führen.

Verantwortlich für die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.
New Orchard Road
Armonk, New York 10504
Tel: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:
IBM Deutschland GmbH
Technical Regulations, Abteilung M372
IBM-Allee 1, 71139 Ehningen, Germany
Tel: +49 (0) 800 225 5423 or +49 (0) 180 331 3233
email: halloibm@de.ibm.com
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Generelle Informationen:

Das Gerät erfüllt die Schutzanforderungen nach EN 55024 und EN 55032 Klasse A.

Electromagnetic Interference (EMI) Statement - Russia
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